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High Voltage Calibration

Abstract

We have developed a procedure for the high voltage calibration of the TANSY
neutron detectors. The procedure is based on the work done during the construction of
the spectrometer.

A special CODAS program is written for the measurement of the sensitivity of
the neutron detectors as a function of the high voltage. The data are transferred to a
PC for the evaluation of the data. We use a Cobalt source during the calibration. With
the interactive PC program "HIVOCA" the voltage corresponding to the effective
compton edge is found. The voltage settings for the neutron detectors are calculated
and stored in a file suitable for input to the progam "PARA", that is used to control the
instrument.

A measurement is reported that shows that the reproducibility of the
measurement is good.

TANSY -2 - - KM5



High Voltage Calibration

Contents

1. Introduction 4
2. The method 4
3. The measurement 5
4. The evaluation using the program HIVOCA 7
5. Results of a calibration 8
6. The HIVOCA help file 12

6.1. Contents 12
6.2. Introduction 12
6.3. The Calibration Method 13
6.4. The Measurement 13
6.5. The Evaluation 13
6.6. The Main Form 14

6.6.1. The Main Form Menu 14
6.7. The Analysis Form 15

6.7.1. The Analyses Form Menu 16
6.7.1.1. The File Menu 16
6.7.1.2. The Tools Menu 16
6.7.1.3. The View menu 17
6.7.1.4. The SVDK Menu 17

6.7.2. The Navigation Command Buttons 17
6.7.3. The Evaluation Tools 18

6.7.3.1. The Evaluate Command Button 18
6.7.3.2. The More-3 Command Button 18
6.7.3.3. The More-4 Command Button 18

6.8. The Result of the Analyses 19
6.9. The Files 20

6.9.1. The Input File for the HV Scan 20
6.9.2. The HV Scan results (.DAT) 20
6.9.3. The System Data File (.HVP) 21
6.9.4. The Result Files (.PAA, .PAB) 22

References

TANSY --3-- KM5



High Voltage Calibration

1. Introduction
The foil scattered neutrons reaching the neutron detectors in TANSY have energies
from approximately .5 to 3 MeV. The high voltage calibration tools are designed to
find high voltage settings appropriate for this energy range.

The neutron energy range is defined by the high voltage and the lower and
upper discriminator levels. Other factors that have an influence on the range is the
preamplifier bias level and the attenuation of the signals. The bias is adjusted to zero
prior to the calibration and the attenuation is supposed to be constant as long as no
changes are made in the cabling of the instrument.

Appropriate default values for the discriminator levels have been found during
the design phase of the instrument. They are adjusted as carefully as possible to the
default values. Only the lower level discriminators are used during the calibration.

The Compton edge created by gamma from a Cobalt source is used during the
calibration. It is placed as centrally as possible and the high voltage is stepped through
a predefined range. The number of counts during a predetermined time is registered for
each step. The result is evaluated using the program HIVOCA. The high voltages
found are stored and inserted in the parameter file.

The calibration routines are primarily designed for the calibration of the high
voltage. However, it is an excellent test of the status of the neutron detectors. Any
faults in the optical contact between the scintillator and the photomultiplier or elements
in the amplification chain operating improperly will affect the result of the
measurement.

2. The method
The method has been carefully investigated during the design phase of TANSY and is
reported in the references to this report. Here we give only the main idea of the
method. It is based on the amplification equation for the neutron detectors:

A-—-k-V"
E

A = the amplitude in discriminator units
E = particle (or gamma ray) energy in electron energy units
Eo = a reference energy, 781 keV for the Cobalt Compton edge1

V = the photomultiplier high voltage supply
n = an exponent giving a relation between the photomultiplier voltage and

amplification
k = an amplification factor

A complete calibration includes the determination of n and k. Fortunately, the
factor n depends on the design of the multiplier only and is almost the same for all the

1 Co60 gives two lines, one at 1.17 MeV and one at 1.33 MeV. The neutron detectors cannot resolve
this. The Compton edge used here is an effective value created by the two lines.
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neutron detectors. It has been carefully measured during the construction phase. The
mean value for all detectors is 12.78, a value that can be used for a new photo-
multiplier of the same type. A re-measurement is tedious as it involves several scans of
the high voltage.

The factor k depends on the light output from the scintillators, the transfer of
light to the photocathode, the sensitivity of the photocathode, the signal amplification,
and the setting of the discriminator level. The factor is very different for the different
neutron detectors. However, we do not need to know it as long as we do not change
any of the above mentioned factors. Therefore, this calibration scheme is only designed
for a determination of the high voltage settings.

During the design phase parameters were measured also for the upper
discriminator. These values are different as the signal is attenuated between the lower
and upper level circuits. However, the upper level values are not as important as the
lower ones and therefore it is not necessary to do a re-calibration of these levels

If we apply the equation to the two cases of cobalt and neutrons we get the
setting of the high voltage, V, to

-
cobalt T-

vVwhere Vcobalt correspond to the inflexion point obtained from the result of a scan of the
high voltage. E is the energy of the discrimination level. It is presently set to 100 keV
corresponding to a neutron energy of about .7 MeV. It is slightly above the design
value for the lowest neutron energy.

3. The measurement
Most of the TANSY calibrations are controlled by the PC connected to the Starburst
computers. However, the Starburst computers can only control modules in their own
CAMAC crate. During this measurement we use the controller for the high voltage
units and the latching sealers, both not accessible from the Starburst computers.
Therefore, a special CODAS program has been written for this purpose.

The program scans the high voltage in predetermined steps. For each step the
number of counts from the neutron detectors is measured during a predetermined time.
The result is stored in a file used as an input to the HIVOCA program.

An example of the input to the scan program is given below. The line numbers
and comments are not a part of the file. The example gives a total of 21 steps
(5+15+1). The maximum number of steps is 32.

Line 1 to 32 = nominal voltage settings1
2

29
30
31
32
33
34

1800
1517

1447
1410
1391
1476
-15
5

The scan starts 15 steps before the nominal voltage.
It ends 5 steps after the nominal voltage.
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35
36

20
1000

High Voltage Calibration

The Voltage step is here 20 V.
The time for each step is 1000 ms, 1 second

the file.
The output file has the following format. Again the comments are not a part of

32
1257
1265
1273
1281
1289
1297
1305
1313
1321
1329
1337
1345
1353
1361
1369
1377
1385
1393
1401
1409
1417
1425
1433
1441
1449
1457
1465
1473
1481
1489
1497
1505
1185
1193

12
14
15
16
17
18
25
73
318
1105
2837
5804
9809
14461
19312
23950
28197
32006
-29961
-26631
-23571
-20549
-17552
-14649
-12013
-9217
-6606
-3657
-921
1713
4373
6878
13 Nex
14

; 32 voltage steps are used
; Voltage and counts, detector 0 in branch A
;A total of 32 values for this detector

Next detector. The Branch B Detectors follow after Branch A.

and so on for all the 32 neutron detectors

Note that the number of counts change from positive to negative and then back
to positive. It comes from the fact that only 16 bits are used by the sealers. The input
routine in the analyse program HIVOCA takes care of this problem as long as the
difference between the counts in two consecutive steps is less than 32767.
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Prescalers are used to enhance the dynamic range of the sealers. The count-
down factor of the prescalers is not a part of the file but must be remembered and
manually given to the analysis program.

4. The evaluation using the program HIVOCA
The data read into the program are first presented in a graph giving an overview over
all detectors.

File Tools Analyse Help

97770x

87993-^

78216-^

950 1100 1250 1400 1550 1700 1650 2000

Several options are now available to investigate the data. Here we will only
describe the recommended option. The menu item "Analyse Single Detector" activates
the evaluation part of the program. The detectors are investigated one by one normally
starting with detector 0 in Branch A. Start by a zoom to a relevant part of the data.
View the differentiated data. Then you see a window as the following one.

File Tools View SVDK Help

j Evaluate 11 More-3

New High Voltage
1624

OldHV = 1582 | Store Old f
Deviation 42 V

No HV is stored

Calibration Results
from Simple Lin. Fit, 4 Par.
Infloumn Point = 1401 V

6000-

5000-

4000-

3000-

2000:

1000-

0

-10001
131.0 13:

7

1.4 13! 1.9 1372.4 13*2.8 M u 3.7 i 4.2

The left (blue) vertical line shows the old cobalt value. The new one is indicated
by the right (red) one. The evaluation is shown as the curve with the maximum at the
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right vertical line. To get a good fit you must zoom to a better range. Trial and error
gives the following result.

An a fy s e s of Bra n ch A, Deittim Q
File Tools View SVDK Help

JEva|uate| |

"New High Voltage' "'
I 1582 j [jjore New]

OldHV* 1582
Deviation OV

No HV is stored

Calibration Results
Inflexion Point = 1365 V

ITIIH Indovlnn Pninl
1329.1 1336.9 1344.7 1352.6 1360.4 1368.3 1376.1 1383.9 1391.$

In this case the old and the new values coincide. One of them are stored by a
click on either of the store buttons. Sometimes it is valuable to go back to the original
distribution. In this case it gives a deviation of 1 Volt. It is up to the user to decide
upon which value is to be used.

Ah aiy sW bf Bra h ch ;& D eteBoi #
File Tools View SVDK Help

JEvaluatej Lj-^££j j Û m-mfcO
" New High Voltage' "T
I 1583 I j Store Newtj

OldHV= 1582 [ Jj,tore, 0Id J j
Deviation 1 V i

No HV is stored _J

Calibration Results
from Simple Lin. Fit. 4 Par.

4UUUU-

^0000-

ISftftfl.

5000-

ft'nTniiiit ii*ii

c

1329.1 1336.9 1344.7 1352.6 1360.4 1368.3 1376.1 1383.9 139L8

A text window gives some information to help the user. On entering the
evaluation part of the program the user is prompted for an .HVP file. Some of the data
in this file are reproduced in the text window. The file also contains the old high
voltages. It is a text file that may be edited by "write" or "notepad".

The results of the calculations are stored in files (.PAA, .PAB) that can be read
by the parameter program. Note that a reading of these files will only affect the high
voltage values.

More information about the different program options is given in the help file.

5. Results of a calibration
Two overnight measurements were done in October 1996. The Cobalt source was
placed on the vacuum vessel flange close to the foil. In the first measurement it was
placed at the B branch side and in the second at the A branch side of the neutron
detectors. The results are presented in the two following pages.
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The result for the A-branch neutron detectors.

Detector

AO
A1
A2
A3
A4
A5
A6
A7
A8
A9
A10
A11
A12
A13
A H
A15

Source at B

1582
1512
1518
1502
1540
1572
1586
1631
1384
1435
1480
1478
1508
1425
1524
1518

Source at A

1583
1511
1517
1501
1535
1569
1583
1628
1383
1435
1483
1479
1507
1424
1517
1516

Mean value

Difference

-1
1
1
1
5
3
3
3
1
0
-3
-1
1
1
7
2

1.5

Eq. Amp.
Error, %

-0.8
0.8
0.8
0.9
4.1
2.4
2.4
2.4
0.9
0.0
-2.6
-0.9
0.8
0.9
5.9
1.7

1.24

A14

A12

A10

A8

A6

A4

A2

A0

Branch A

- ' "L piiiBJByiiiyiiiiyiiiiiilili'iiiiiiiii'iiiiii'ii

-•' '

"•"•• • ' "• ' " " l f l l l n lrjLUllJlU|IJllJllJlUllJlUIUlUUJlUllJlU|IJUJUJliu!WWllJLIJLU

-•' i " " Illllllllllllllllllllllllll

- L""L L'"'L ' | } Ti llirim Ii

' ' iiiiiiiiiiiiS

• Source at A

O Source at B

1200 1300 1400 1500 1600 1700

TANSY .-9-. KM5



High Voltage Calibration

The result for the B-branch neutron detectors.

Detector

BO
B1
B2
B3
B4
B5
B6
B7
B8
B9
B10
B11
B12
B13
B14
B15

Source at B

1568
1526
1440
1403
1398
1510
1292
1493
1239
1519
1414
1575
1576
1399
1399
1471

Source at A

1569
1532
1443
1404
1400
1513
1297
1494
1241
1521
1419
1578
1580
1399
1396
1471

Mean value

Difference

-1
-6
-3
-1
-2
-3
-5
-1
-2
-2
-5
-3
-4
0
3
0

-2.1875

Eq. Amp.
Error, %

-0.8
-5.0
-2.7
-0.9
-1.8
-2.5
-4.9
-0.9
-2.1
-1.7
-4.5
-2.4
-3.2
0.0
2.7
0.0

-1.92

Branch B

B14"

B12 "

B10"

B8"

B6 "

B4

B2"

BO

fflSSf

HMIWMffliiUliy

f

5*

fX-j V ' ••rivrlvfJ

1200 1300 1400 1500

High Voltage

1600 1700

• Source at A

U Source at B
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The differences between the two measurements are small, the mean difference
is about 2 Volt and the maximum difference is 7 Volt. Any of the measurements can be
used. The figure below shows however that the number of counts is about 2.5 times
higher for the detectors closest to the source. Therefore we will use these values as the
result of the calibration.

The voltage differences can be transformed to equivalent amplitude differences.
From our main equation we get

AA AV

From the tables we find a maximum deviation of 6 % and a mean value of less
than 2 %. This is in agreement with the accuracy of the discriminator level settings.

Source at the B detector side
97770-

CM
CO

COc
CO

950 1100 1250 1400 1550 1700 1850 2000

High Voltage
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6. The HIVOCA help file
A help file is provided for the HIVOCA program. We reproduce some parts of it here
as an introduction for the user of the program.

6.1. Contents

Welcome to the TANSY2 high voltage calibration program for the neutron detectors.

Contents:

The Calibration Method
Jhe Mesasurement
The Evaluation

The Main. Form
TJie Main Form Menu

The. A,nalyse.s,Form
The Analyses Form Menu

The File Menu
The Tools Mgpu
The Vjevy Menu
The SVDK Menu

Jhe.Navigation Corrmiand Buttons

The Evaluate Commaiid Button
The More 3 Command Button
TheMpreACommand Button

The,. Result ..ofThe. Analyses
XhjJEilss

The input file for the HV Scan
The Scan Results (.DAT\

The Result Files.

6.2. Introduction
The calibration is based on a method developed at the Department of Reactor Physics, Chalmers
University of Technology. It has been documented in reports as referred to in the reference section of
this help file.

A Cobalt source is placed centrally in the TANSY instrument. The high voltages of the neutron
detectors are stepped and the number of pulses at each step is recorded.

The pulses recorded as a function of the high voltage, have an inflexion point indicating the energy of
the Cobalt-60 Compton edge.

2 TANSY is a neutron spectrometer for D-T neutrons at JET.
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The purpose of the calibration is to determine the inflexion point and relate it to the corresponding
neutron energy. The result of the calibration is the high voltage values to be used by the neutron
detectors.

6.3. The Calibration Method

The energy of the scattered neutrons in TANSY ranges from about 0.5 to 3 MeV. The corresponding
electron energies are 100 and 1400 keV, respectively. The sensitive energy interval of the neutron
detectors is defined by the voltage of the photomultiplier supply and the lower and upper levels of the
discriminators.

6.4. The Measurement

A Cobalt source is placed as centrally as possible in the spectrometer. The voltages are scanned and
the number of counts for each detector is recorded.

The cables from the upper discriminators of the coincidence modules should be disconnected and the
count-down factor should be set to an appropriate value. Only 15 bits3_are used for positive numbers
in the sealers.

The Calibration measurement is controlled by a CODAS program written by Donald Wilson. The
input file contains information about nominal voltages, number of steps before and after the nominal
voltages, the step voltage, and the measurement time. An example of an input file is given in the Files
topic.

The resulting file contains the number of detectors4 in the first line. It is followed by the voltages and
counts recorded for all detectors. See the Files topic for more details. The result is copied by FTP to
the .DAT file5 in the PC and is used as input to this program.

6.5. The Evaluation

• Start the program by clicking on the Icon.
Choose an input file from the alternatives presented in the file input dialogue.

The count distributions for all detectors are displayed. Use the display for a first look at the
result.

Click Analyse Single Detector in the Analyse menu.
You are prompted for a choice of the Count Down factors. These are not included in the files
but must be noticed and remembered manually.

In the "Single Detector Analysis" form you are able to navigate through the results for all the
detectors. Several options are available for the determination of the inflexion point. You can display

3 Max 32767 counts
4 We use 32 detectors in TANSY, numbered from 0 to 31.
5 We use Mymdd#.DAT, year, month(hex), day, and experiment #.
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the integral curves or the differentiated curve. You can use zooming for selecting the points included
in the analysis. You may use 3-parameter or 4-parameter analyse to get the inflexion point.

The result is presented in the "New High Voltage" frame. A text box contains additional information.

Use the "Store" buttons to store either the old or the new high voltage.

After the evaluation of all the detectors the result is saved, appended to file, which can be read by the
parameter program, PARA. Save is only permitted after an analysis of all the detectors.

6.6. The Main Form

The main form is the entrance to the program. It gives an overview of all the detectors.

1
File Tools Analyse Help

50W.7
4S0M'
1*43.1-

0.0

f
I

! t
I j

! I
! I I

/ 1
I ' •
F if;

_/£
JM.

f &

w
fjffi
fa*

lit'
it)

not 1250 <4oo «s« i7«« 1«O

6.6.1. The Main Form Menu

n-
With File you open a new project or exit the program.

Tools gives you options for manipulating the graphic. You can enlarge the display using Zoom. The
"toolbar" gives you access to the graph library options. However, only some of the options are
relevant. Only the data are loaded.

'eiSingfe Detector
I I I I I

Analyse brings you to the analyse part of the program. The detectors are analysed one by one using
several tools available in that program.
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6.7. The Analysis Form

The form is started from the main menu, "Analyse Single Detector"
Before entering the form you are prompted for the reference file6, .HVP, and the Count Down Factor7

used at the measurement.

The .HVP-file is a background file containing the reference voltages, old voltages, and information
about the system, i.e., the discriminator settings.

The "Count Down Factor" is the one used at the measurement. A value in the .HVP file is presented
as a first value. However, as this is a standard file, the Count Down Factor should be documented in
some other way.

Analyses Of Branch A, Detector 0
File Tools View Help

JEvaluateJ [jjowjj-Qj[ogB~!JJ

New High Voltage
I
[jSlorejmdJ

No HV is stored

No Results 350 1100 1250 1400 1950 1700 1850 2000 -V

File Name:

jcth.hvp

fiirect

d:\tan

Count Down Factor
.Sv"»;:S',-w:v:--.''v:-:;:-.-.:.v:v
- ; . ^ - ; ; ; ; - ; ^ W ' X - : • : • : - x • : • . • . : - : • : • : • : • :

>;i::^-^:i;:5:^:Svx:r:x:x:':x:x::

Hiiiiiii
:
' Done
'::•" - . . : ; : : ; ' . \ v . - • • • .:-.-:•:-.•:-.-.-:-<••-

~
:
;\:{.

 :
x - :

:
: - ; - x ' x - x - " T - r : ;•>:>•;>

"•-;; -.';:-' ';••:•• . : ; ! : S S : $ S S £

; l l | r

:J::"|::>:<; t

J-*•-:&}•*•:'.
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6.7.1. The Analyses Form Menu

File Tools View Help

The Analyses Form Menu enables you to save the result, get new data, manipulate the graph, and
differentiate the distribution.

6.7.1.1.The File Menu

"Get Parameters" gives you access to a new .HVP file. You are prompted for an update of theCount
Down Factor.

"Exit" is an exit to the main form in which you may load a new experiment.

"Save" saves the result of the calibration, the high voltage values. The values are appended to files of
type.PAA and .PAB, formatted for the use of the parameter program PARA.

Save is only permitted when all detectors are calibrated. If not, the missing ones are listed in a
message box.

6.7.1.2.The Tools Menu

j( Show Error Bars
Show Toolbar

H riign vencage

Zooming.
1) Click on zoom in the menu.

2) Click on the left low corner of the zooming region. A rectangle is shown as soon as you
move the mouse

3) Expand the rectangle to the right high corner and click again

A first evaluation is done. The evaluated inflexion point is shown as a red line in the diagram, the old
one is marked by a blue colour. The resulting curve is shown in red.

The zooming can be repeated to a smaller region. "Reset Zoom" resets the zooming to a full display.

Show Error Bars
Error bars are shown and may be taken away by clicking "Hide Error Bar".
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Show Toolbar

The toolbar is supplied for the experienced user of the Graph Library. Only some options are relevant.
However, it enables possibilities to edit, print, save, or copy the graph. Click "Hide toolbar" to get rid
of it.

6.7.1.3.The View menu

Sealer Count Down Factor
.si i j wore-* ii

Show Diff. Distr.
An alternative method to find the inflexion point is to differentiate the measured data and search for
the maximum value. The Diff. Distribution is defined as the difference between consecutive points in
the distribution.

Show Distribution reloads the original values.

Sealer Count Down Factors
The least-square evaluations "More 3" and "More 4" take the variances of the input data into account.
These variances depend on the pre-scaling defined by the count-down factors. Here is a possibility to
check and correct them.

6.7.1.4.TheSVDKMenu

The evaluation options given in the SVDK menu use the routine SVDFIT translated to visual basic
from the FORTRAN routine described in Numerical Recipes. Normally it is not needed but it may be
used for a further analyse of the data.

Tolerance
A low value of the tolerance level removes higher order terms in the polynomial expansion.

SVDK More-3 corresponds to the More-3 button
SVDK More-4 corresponds to the More-4 button

Test creates data points from the last evaluated power series. The standard deviations of the data
points are the square root of the data values. Return to the original data points by clicking the "Set
Test Off item of the menu.

6.7.2. The Navigation Command Buttons

_ 8 I 7T^

Select the detector number using the buttons.
The actual detector is shown as the form caption.
A-0 or B-0 displays the first detector in the A-branch and the B-branch.
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6.7.3. The Evaluation Tools

:j Evaluate 11 More-3 I I More-4

Three types of evaluation are available. All of them use power series. They may be applied to the
direct data as well as the differentiated data with one exception.

Evaluate is the evaluation offered by the graphic library.
More-3 and More-4 is power series with 3 and 4 parameters, respectively.

The text changes to red for the actual evaluation.

6.7.3.1. The Evaluate Command Button
f.*s*;*'M*i
1 Evaluate I
The mean-square evaluation offered by the graphic library uses the data with no weights included. No
correlation matrix is returned.

The evaluation uses four parameters for the direct data and three parameters for the differentiated
data. No statistical data are reported.

This evaluation is automatically done when a new detector is selected.

6.7.3.2.The More-3 Command Button

More-3 is a three parameter power series evaluation using the least-mean-square method.
It is enabled for the differentiated distribution only.
The standard deviation is reported on the graph as dotted lines but only if the limits are inside the
graph range. Small standard deviation is covered by the red line indicating the inflexion point. The
full covariance matrix is taken into account.

6.7.3.3.The More-4 Command Button
! Moie-4 J

More-4 is a four parameter power series evaluation using the least-mean-square method.
The standard deviation is reported on the graph as dotted lines but only if the limits are inside the
graph range. Small standard deviations are covered by the red line indicating the inflexion point. The
full covariance matrix is taken into account.

A four-parameter evaluation on differentiated data gives high standard deviations unless the data are
of a very good quality. Very high standard deviations are reported as "Error". However, the estimated
high voltage may still be valuable.
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6.8. The Result of the Analyses

-CS3QIH
Evaluate 11 :More-3.l I More-4

flgflyflyfi^yfl^ft^^VftYtYI^T %fllpfippflypm*t*mltmjjjjjjj)}p VSrfcft̂ VWtfV^W^V^Vft

"New High Voltage

1589

OldHV = 1596
Deviation -7 V

No HV is stored

Calibration Results
Inflexion Point = 1411 V
Std. Deviation = 4 V
Old Inflexion Point = 1418V
Chi Square = 39
New High Voltage = 1589 V
Old High Voltage = 1596 V f 13&4 1343.9 t3̂ 9.1 138(95 14 14#.3 14̂ 0.6 HI
Lower Level Discr. = 150 mV
Upper Level Discr. = 927 mV

The result of the analyses is presented in three ways.

The graph has a blue line for the old inflection point and a red line supported by two dashed red lines
for the evaluated inflexion point and its standard deviation.

r New High Voltage"
1589

OldHV» 1596
Deviation -7 V

Store Old

No HV is stored

The result frame gives the evaluated new high voltage and the old one as a comparison. Either of
these can be stored and saved at the time all the detectors are analysed. You may go back to the
detector at any time and redo the evaluation and save the new result. There is a notice in the frame
indicating the type of result stored.

Calibration Results
Inflexion Point = 1411 V
Std. Deviation = 4 V
Old Inflexion Point = 1418 V
Chi Square = 39
New High Voltage = 1589 V
Old High Voltage = 1596 V
Lower Level Discr. = 150 mV
Upper Level Discr. = 927 mV

The text box gives additional information from the HVP file and the evaluation.
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6.9. The Files

Input Files
.DAT output from the HV scan program created by Donald Wilson.

Input to this program.
.HVP A file containing the old voltage data and some system information.
.PAA The resulting high voltage settings for branch A are appended to this file
.PAB The resulting high voltage settings for branch B are appended to this file

All files are text files and can be edited by ,e.g. Notepad.

6.9.1. The Input File for the HV Scan

The input to the Donald Wilson scan program: The line numbers and comment are not a part of the
file. The example gives a total of 21 steps (5+15+1). The maximum number of steps is 32.
1 1800 Line 1 to 32 = nominal voltage settings
2 1517

29
30
31
32
33
34
35
36

1447
1410
1391
1476
-15
5
20
1000

The scan starts 15 steps before the nominal voltage.
It ends 5 steps after the nominal voltage.
The Voltage step is here 20 V.
The time for each step is 1000 ms, 1 second

6.9.2. The HV Scan results (.DAT)

The resulting file named .DAT in the PC. Only the first part is reproduced here. The data are taken
from a measurement using the input data shown in the preceding page.

1 21 The number of steps in the scan.
2 1500 1788 Detector l,A-0, voltage and counts for each step.
3 1520 1922
4 1540 2101

19
20
21
22
23
24
25

1840
1860
1880
1900
1217
1237
1257

2561
2520
2438
2320
78
94
97

Detector 2, A-l
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6.9.3. The System Data File (.HVP)

Some parameters are collected here and reproduced in the Analyses Text Box during the analyses of
the data.

;SETTINGS for energy-calibrated NEUTRON DETECTORS.
; Syntax:; in first position = comment line
; Three letters in the first positions = parameter name
; a / in position 4 after the name = parameters on 2 lines
; The parameters are capital letters or figures separated by
; anything else.

; Input data: Low Upper Level Neutron Energy in keV
ELL 100.0
EUL 1400.0

; Calibration parameters: Co-60 Energy in keV
ECO = 781.0
; Neutron detector parameters: VERSION 1 of 09-MAY-90
; Constant C Lower Level A side
ALC/ -95.59770 - -92.98448 - -92.67700 - -94.71216 -94.02595- -94.15124 - -95.71883 - -95.37336

-89.64796 - -94.05767 - -92.60953 - -93.63454 - -94.35622 - -95.02723 - -96.64515 - -90.92054
; Constant N Lower Level A side
ALN/ 13.9199— 13.6593-- 13.6140-- 13.9067-- 13.7617-- 13.7548-- 13.9254- 13.8737

13.3720-- 13.8962-- 13.6415-- 13.7802-- 13.8519-- 14.0444-- 14.1437- 13.3984
; Constant C Upper Level A side
AUC/ -95.93807-97.03045-94.83014-96.51661-94.33855-93.86630-93.99732-97.10278

-92.16994 -92.76257 -92.78299 -94.57716 -97.09632 -95.59081 -98.74255 -92.85490
; Constant N Upper Level A side
AUN/ 13.8552-- 14.1008-- 13.7963-- 14.0441- 13.6972-- 13.6082-- 13.5837-- 14.0017

13.6088— 13.6038-- 13.5531-- 13.7974- 14.1143-- 14.0087-- 14.3156— 13.5530
; Constant C Lower Level B side
BLC/ -94.32612- -94.69771- -95.20302- -91.35313- -93.16808- -93.91614- -85.90939- -92.92239

•85.10455- -96.38091- -93.43744- -101.54265- -94.26544- -93.53030- -92.13696- -92.13000
; Constant N Lower Level B side
BLN/ 13.7845-- 13.8778-- 14.0554-- 13.5781- 13.8366-- 13.7961-- 12.9904-- 13.6960

12.9348- - 14.1114- - 13.8595- - 14.6917- 13.9245- - 13.8722- - 13.7060- - 13.5939
; Constant C Upper Level B side
BUC/ -97.53858- -96.95764- -93.84972- -94.32944- -94.18201 - -96.26985- -85.23893- -92.48105

-80.74310- -97.91914- -91.37764- -106.64184- -94.83786- -93.36443- -93.20802- -94.02959
; Constant N Upper Level B side
BUN/ 14.1077- - 14.0739- - 13.7565- - 13.8779- 13.8629- - 14.0069- - 12.7811- - 13.5235

12.2098-- 14.2092-- 13.4656-- 15.2696- 13.8927-- 13.7377-- 13.7402-- 13.7413

; SETTINGS FOR NEUTRON DETECTORS -
; The following values may be positive or negative.
; They will in both cases be used as positive numbers in the program.
; Note that the names are not the same as in files .PAA and .PAB
; However, the structure is the same, values can be copied from .PAA or .PAB

; Lower Level Discriminators Branch A
ALL/

;Upper I
AUL/

150.
150.

150.
150.

150.
150.

Level Discriminators Branch A
927.
935.

932.
913.

; High Voltages Branch A
AHV/ 1596.

1384.
1517.
1447.

; Lower Level Discriminators
BLL/ 150.

150.
150.
150.

927.
925.

1520.
1490.

Branch B
150.
150.

150.
150.

945.
928.

1508.
1492.

150.
150.

150.
150.

957.
926.

1550.
1513.

150.
150.

150.
150.

949.
922.

1570.
1436.

150.
150.

150.
150.

943.
909.

1605.
1529.

150.
150.

150.
150.

959.
940.

1610
1500

150.
150.

; Upper Level Discriminators Branch B
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BULV 911.
939.

; High Voltages
BHV/ 1565.

1244.
; Count Down
CDO 1
; End of Data

923.
924.

Branch B
1530.
1527.

1

923.
947.

1445.
1410.

941.
918.

1406.
1624.

922.
940.

1400.
1447.

934.
935.

1510.
1410.

918.
922.

1283.
1391.

927.
921.

1481
1476

6.9.4. The Result Files (.PAA, .PAB)

Parameters # 19, Branch AA at August-29-1995--12-56

Syntax: ; in first position = comment line
Three letters in the first positions = parameter name
a / in position 4 after the name = parameters on 2 lines
The parameters are capital letters or figures separated by
anything else.

The spare parameters use the syntax SPRindex value explanation
Branch AA or BB, ASCII.

BRN AA
Option of data, date or some other identification, Unsigned integer

OPT 19
Number of memories in the system, 1, 2, or 3

MSY 3

; High Voltage Settings from D:\TANSYEVA\HIVOCA\DATA\CTH.HVP
; or from High Voltage Calibr. D:\TANSYEVA\HIVOCA\DATA\M563081.DAT
; at April-17-1996--09-46
; Values in V
NDB/ -1596 -1517 -1520 -1508 -1550 -1570 -1605 -1610

-1384 -1447 -1490 -1492 -1513 -1436 -1529 -1500
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